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 Avaya Solution & Interoperability Test Lab 
 

Application Notes for Configuring Primus SIP Trunking 

with Avaya IP Office Release 8.0 – Issue 1.0 

 
 

Abstract 
 

  

These Application Notes describe the steps to configure Session Initiation Protocol (SIP) 

Trunking between Primus and Avaya IP Office Release 8.0. 

 

Primus SIP Trunking provides PSTN access via a SIP trunk between the enterprise and the 

Primus network as an alternative to legacy analog or digital trunks.  This approach generally 

results in lower cost for the enterprise. 

 

Information in these Application Notes has been obtained through DevConnect compliance 

testing and additional technical discussions.  Testing was conducted in the Avaya Solutions 

and Interoperability Test Lab, utilizing Primus SIP Trunk Services. 
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1. Introduction 
These Application Notes describe the steps to configure Session Initiation Protocol (SIP) 

Trunking between Primus and Avaya IP Office Release 8.0. 

 

The Primus SIP Trunking service referenced within these Application Notes is positioned for 

customers that have an IP-PBX or IP-based network equipment with SIP functionality, but need 

a form of IP transport and local services to complete their solution. 

 

Primus SIP Trunking will enable delivery of originating traffic and termination of local, long-

distance and toll-free traffic across a single broadband connection.  A SIP signaling interface will 

be enabled to the Customer Premises Equipment (CPE). 

 

2. General Test Approach and Test Results  
The general test approach was to connect a simulated enterprise site to the Primus SIP Trunking 

service via the public Internet and exercise the features and functionality listed in Section 2.1.  

The simulated enterprise site was comprised of Avaya IP Office and various Avaya endpoints. 

 

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members.  The 

jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent 

to the interoperability of the tested products and their functionalities.  DevConnect Compliance 

Testing is not intended to substitute full product performance or feature testing performed by 

DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or 

completeness of a DevConnect member’s solution. 

2.1. Interoperability Compliance Testing 

To verify SIP trunking interoperability, the following features and functionality were covered 

during the interoperability compliance test: 

 

 Response to SIP REGISTER queries 

 Incoming PSTN calls to various phone types including H.323, SIP, digital, and analog 

telephones at the enterprise.  All inbound PSTN calls were routed to the enterprise across 

the SIP trunk from the service provider. 

 Outgoing PSTN calls from various phone types including H.323, SIP, digital, and analog 

telephones at the enterprise.  All outgoing PSTN calls were routed to the enterprise across 

the SIP trunk from the service provider. 

 Inbound and outbound PSTN calls to/from Avaya IP Office Softphone.   

 Various call types including: local, long distance, outbound toll-free and local directory 

assistance. 

 Codec G.711MU, G.729A and G722. 

 T38 Fax. 

 Caller ID presentation and Caller ID restriction. 
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 DTMF transmission using RFC 2833. 

 Voicemail navigation using DTMF for inbound and outbound calls. 

 User features such as hold and resume, transfer, and conference. 

 Off-net call forwarding and twinning.   

2.2. Test Results 

Interoperability testing of Primus SIP Trunking was completed with successful results for all test 

cases with the exception of the observations/limitations described below. 

 

 OPTIONS – Primus does not support OPTIONS messages and therefore this was not 

turned on in IP Office. 

 T.38 Fax – Primus supports T38 fax; however when IP Office was configured to use the 

same, both inbound and outbound faxes used G711 instead of T38.  This is a known issue 

in IP Office 8.0.18. Upgraded the system to 8.0.43 and the issue is still seen. Avaya IP 

Office design is aware of the issue and investigation is in progress at the time of writing 

this document. 

 Codec – Primus only supports G729, G711MU and G722. 

 Inbound Toll Free – Primus does not offer this service and therefore requested not to 

test this feature. 

 Emergency Calls – Primus had not setup address/location and therefore while testing 

emergency calls, 911 agents were able to see the calling number only. 

2.3. Support 

For technical support on Primus SIP Trunking, contact Primus using the Customer Service links 

at http://businesssupport.primus.ca/. 

http://businesssupport.primus.ca/
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3. Reference Configuration 
Figure 1 illustrates the sample configuration used for the DevConnect compliance testing.  The 

sample configuration shows an enterprise site connected to Primus SIP Trunking. 

 

Located at the enterprise site is an Avaya IP Office 500.  The LAN1 port of Avaya IP Office is 

connected to Lab Network which is connected to the Public Network.  Endpoints include an 

Avaya 1608 IP Telephone (with H.323 firmware), an Avaya 1140E IP Telephone (with SIP 

firmware), an Avaya 9650 IP Telephone (with H.323 firmware), an Avaya 9508 Digital 

Telephone, a Fax machine and a traditional Analog Telephone.  The site also has a Windows XP 

Professional 2002 SP3 Server running Avaya Voicemail Pro for voicemail, Avaya IP Office 

Manager to configure the Avaya IP Office, Avaya Phone Manager and Avaya IP Office 

Softphone, 

 

 
 

Figure 1: Avaya Interoperability Test Lab Configuration 
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For security purposes, any public IP addresses or PSTN routable phone numbers used in the 

compliance test are not shown in these Application Notes.  Instead, public IP addresses have 

been replaced with private addresses and all phone numbers have been replaced with numbers 

that cannot be routed. 

 

In an actual customer configuration, the enterprise site may also include additional network 

components between the service provider and the Avaya IP Office such as a session border 

controller or data firewall.  A complete discussion of the configuration of these devices is beyond 

the scope of these Application Notes.  However, it should be noted that SIP and RTP traffic 

between the service provider and the Avaya IP Office must be allowed to pass through these 

devices. 

4. Equipment and Software Validated 
The following equipment and software were used for the sample configuration provided: 

 

Equipment Software 

Avaya IP Office 500v2 8.0 (18) 

Avaya IP Office Manager 10.0.18 

Avaya IP Office Voicemail Pro 8.0 (80029) 

Avaya 9650 IP Telephone (H.323) 3.186a 

Avaya 1608 IP Telephones (H.323) 1.300B 

Avaya 1140 SIP Telephones  04.03.09.00 

Avaya 9508 Digital Telephone N/A 

Avaya Analog Telephone N/A 

Avaya IP Office Softphone 3.2.3.15_64595 

Avaya IP Office Phone Manager Lite 4.2.39 

Service Provider Software 

SBC : Genband S3 6.0.3.15 

Broadsoft Broadworks R17 SP4 

  

5. Configure Avaya IP Office 
Avaya IP Office is configured through the Avaya IP Office Manager PC application.  From the 

Avaya IP Office Manager PC, select Start → Programs → IP Office → Manager to launch the 

application.  A screen that includes the following in the center may be displayed: 
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Navigate to File → Open Configuration (not shown), select the proper Avaya IP Office system 

from the pop-up window and log in with the appropriate credentials.  The appearance of the IP 

Office Manager can be customized using the View menu. In the screens presented in this section, 

the View menu was configured to show the Navigation pane on the left side and the Details pane 

on the right side.  These panes will be referenced throughout the Avaya IP Office configuration.  

All licensing and feature configuration that is not directly related to the interface with the service 

provider (such as twinning and IP Office Softphone support) is assumed to already be in place. 

5.1. Licensing and Physical Hardware 

The configuration and features described in these Application Notes require the IP Office system 

to be licensed appropriately.  If a desired feature is not enabled or there is insufficient capacity, 

contact an authorized Avaya sales representative.  
 

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in 

the Navigation pane and SIP Trunk Channels.  Confirm a valid license with sufficient 

Instances (trunk channels) in the Details pane.  
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If Avaya IP Telephones will be used as is the case in these Application Notes, verify the Avaya 

IP endpoints license.  Click License in the Navigation pane and Avaya IP endpoints. Confirm a 

valid license with sufficient Instances in the Details pane. 

 

 
 

 The VCM is a Voice Compression Module supporting VoIP codecs.  An IP Office hardware 

configuration with a VCM component is necessary to support SIP trunking. 

 

The following screen shows the modules in the IP Office used in the sample configuration.  To 

access such a screen, select Control Unit in the Navigation pane to show the modules.  In the 

screen below, IP 500 V2 is selected, revealing additional information about the IP 500 V2 in the 

Details pane. 
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5.2. LAN1 Settings 

In the sample configuration the LAN port was used to connect the Avaya IP Office to the public 

network.  The LAN1 settings correspond to the LAN port on the Avaya IP Office 500.  To access 

the LAN1 settings, first navigate to System in the Navigation Pane and then navigate to the 

LAN1 → LAN Settings tab in the Details Pane.  Set the IP Address and IP Mask field to the IP 

address and mask assigned to the Avaya IP Office LAN port. All other parameters should be set 

according to customer requirements. 
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On the VoIP tab in the Details Pane, check the SIP Trunks Enable box to enable the 

configuration of SIP trunks.  The RTP Port Number Range can be customized to a specific 

range of receive ports for the RTP media.  Based on this setting, Avaya IP Office would request 

RTP media be sent to a UDP port in the configurable range for calls using LAN1.  During 

compliance testing the number range were left at default values. Avaya IP Office can also be 

configured to mark the Differentiated Services Code Point (DSCP) in the IP Header with specific 

values to support Quality of Services policies for both signaling and media.  The DSCP field is 

the value used for media and the SIG DSCP is the value used for signaling.  The specific values 

used for the compliance test are shown in the example below and are also the default values.  All 

other parameters should be set according to customer requirements. 
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On the Network Topology tab in the Details Pane, configure the following parameters:  

 

 Select the Firewall/NAT Type from the pull-down menu that matches the network 

configuration.  No firewall or network address translation (NAT) device was used in the 

compliance test as shown in Figure 1, so the parameter was set to Open Internet.  

 Set Binding Refresh Time (seconds) to 0.  This value is used to determine the frequency 

at which Avaya IP Office will send SIP OPTIONS messages to the service provider.  

 Set Public IP Address to the IP address of the Avaya IP Office LAN port.  

 Set the Public Port to 5060. 

 All other parameters should be set according to customer requirements. 

 

 

5.3. Voicemail Settings 

On the Voicemail tab in the Details Pane, select Voicemail Lite/Pro from the drop down for the 

Voicemail Type field. Configure the IP address of the server where the Voicemail is installed in 

the Voicemail IP Address field. Retain default values for the rest of the fields. 

  

 



 
RS; Reviewed: 

SPOC 7/6/2012 

Solution & Interoperability Test Lab Application Notes 

©2012 Avaya Inc. All Rights Reserved. 

11 of 34 

PrimsSipTrkIPO8 

 

 

5.4. System Telephony Settings 

On the Telephony tab in the Details Pane, uncheck the Inhibit Off-Switch Forward/Transfer 

box to allow call forwarding and call transfer to the PSTN via the service provider across the SIP 

trunk.  If for security reasons incoming calls should not be allowed to transfer back to the PSTN 

then leave this setting checked. 

 

 

5.5. Twinning Calling Party Settings 

To view or change Twinning settings, select the Twinning tab as shown in the following screen. 

The Send original calling party information for Mobile Twinning box is not checked in the 

sample configuration, and the Calling party information for Mobile Twinning is left blank.  
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5.6. IP Route 

Navigate to IP Route in the left Navigation Pane, and then right-click to select New (not shown).  

Create a default route with the following parameters: 

 

 Set IP Address and IP Mask to 0.0.0.0. 

 Set Gateway IP Address to the IP Address of the default router to reach LAN1. 

 Set Destination to LAN1 from the pull-down menu. 

 

 

5.7. Codecs 

Since Primus supports G711MU, G729 and G722, only these codecs were selected from the 

codec selection as shown in the screen below. 
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5.8. SIP Line 

A SIP line is needed to establish the SIP connection between Avaya IP Office and Primus SIP 

Trunking.  To create a SIP line, begin by navigating to Line in the Navigation Pane.  Right-click 

and select New → SIP Line (not shown).   

5.8.1. SIP Line – SIP Line Tab 

On the SIP Line tab in the Details Pane, configure the parameters as shown below.  

 

 Set ITSP Domain Name to the domain name of Primus SIP as provided by the partner.  

 Set Send Caller ID to P Asserted ID.  This field allows selection of the value the SIP 

Line should use for the original calling party ID when routing twinned calls. 

 Check REFER Support. 

 Check the In Service box.  This makes the trunk available to incoming and outgoing 

calls. 

 Uncheck the Check OOS box.  The Options feature is not supported see Section 2.2 for 

details. Default values may be used for all other parameters. 
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5.8.2. SIP Line – SIP Credentials 

Primus requires trunk registration using credentials. In the screen below, from the SIP 

Credentials tab add the User name, Authentication Name and Password provided by the 

partner. Check the Registration required box. Retain default values for the remaining fields. 

 

 

5.8.3. SIP Line - Transport Tab 

Select the Transport tab.  Set the parameters as shown below.  

 

 Set ITSP Proxy Address to the IP address of the Primus SIP proxy.  

 Set Layer 4 Protocol to UDP.    

 Set Use Network Topology Info to the network port configured in Section 5.2.  

 Set the Send Port to 5060.  

 Default values may be used for all other parameters. 
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5.8.4. SIP Line - SIP URI Tab 

A SIP URI entry must be created to match each incoming number that Avaya IP Office will 

accept on this line.  Select the SIP URI tab, and then click the Add button and the New Channel 

area will appear at the bottom of the pane.  To add an entry, click on the ADD button.  In the 

example screen below, a previously configured entry is shown.  The entry was created with the 

parameters shown below: 

 

 Set Local URI, Contact and Display Name to Use Internal Data.  This setting allows 

calls on this line whose SIP URI matches the number set in the SIP tab of any User as 

shown in Section 5.1010.  

 From the Registration drop down menu, select the value that was configured in Section 

5.8.2. 

 Associate this line with an incoming line group by entering a line group number in the 

Incoming Group field.  This line group number will be used in defining incoming call 

routes for this line.  Similarly, associate the line to an outgoing line group using the 

Outgoing Group field.  The outgoing line group number is used in defining short codes 

for routing outbound traffic to this line.   

 Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed 

using this SIP URI pattern. 
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5.8.5. SIP Line - VoIP Tab 

Select the VoIP tab, to set the Voice over Internet Protocol parameters of the SIP line.  Set the 

parameters as shown below. 

 

 Set the Codec Selection field to System Default to allow the service provider supported 

codec which were already configured in Section 5.7.  

 Uncheck the VoIP Silence Suppression box. 

 Check the Re-invite Supported box. 

 Set the Fax Transport Support to T38. See Section 2.2 for additional fax 

considerations. 

 Set the DTMF Support field to RFC2833.  This directs Avaya IP Office to send DTMF 

tones using RTP events messages as defined in RFC2833. 

 Default values may be used for all other parameters. 

  

Click the OK button at the bottom of the page (not shown). 
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5.8.6. SIP Line – T38 Fax Tab 

In the T38 Fax tab the Use Default Values box was checked for this compliance testing. User 

can uncheck this box and change the various values of the fields in this tab as required. 
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5.9. Short Codes 

Define a short code to route outbound traffic to the SIP line.  To create a short code, right-click 

on Short Code in the Navigation Pane and select New (not shown).  On the Short Code tab in 

the Details Pane, configure the parameters as shown below. 

 

 In the Code field, enter the dial string which will trigger this short code, followed by a 

semi-colon.  In this case, 9N;.  This short code will be invoked when the user dials 9 

followed by any number. 

 Set Feature to Dial.  This is the action that the short code will perform. 

 Set Telephone Number to N“@preprod.bvoice.primus.ca”.  This field is used to 

construct the Request URI and To headers in the outgoing SIP INVITE message.  The 

value N represents the number dialed by the user.  The address preprod.bvoice.primus.ca 

represents the address of the Primus SIP proxy. 

 Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on 

the SIP Line in Section 5.8.44.  This short code will use this line group when placing the 

outbound call. 

  

Click the OK button (not shown). 
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The following screen illustrates a short code that acts like a feature access code rather than a 

means to access a SIP Line.  In this case, the Code FNE00 is defined for Feature FNE Service 

to Telephone Number 00 (Mobile Call Control).  This short code will be used as means to allow 

a Primus DID to be programmed to route directly to this feature, via inclusion of this short code 

as the destination of an Incoming Call Route.  See Section 5.111.  This feature is used to provide 

dial tone to twinned mobile devices (e.g., cell phone) directly from IP Office; once dial tone is 

received the user can perform dialing actions including making calls and activating Short Codes. 

 

 
 

5.10. User 

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP 

line defined in Section 5.88.  To configure these settings, first navigate to User in the Navigation 

Pane, and then click on the user to be modified.  Select the SIP tab in the Details Pane.  The 

values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in 

the From and Contact headers for outgoing SIP trunk calls and allow matching of the SIP URI 

for incoming calls without having to enter this number as an explicit SIP URI for the SIP line.  

See Section 5.8.44.  The example below shows the settings for User 29225.  The SIP Name and 

Contact are set to one of the DID numbers assigned to the enterprise from Primus.  The SIP 

Display Name (Alias) parameter can optionally be configured with a descriptive name.  If all 

calls involving this user and a SIP Line should be considered private, then the Anonymous box 

may be checked to withhold the user’s information from the network.  Click the OK button (not 

shown). 
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The following screen shows the Mobility tab for User 29226.  The Mobility Features, Mobile 

Twinning and Mobile Call Control boxes are checked.  The Twinned Mobile Number field is 

configured with the number to dial to reach the twinned mobile telephone over the SIP trunk, in 

this case 6139675281.  Other options can be set according to customer requirements. This is the 

configuration used during compliance testing for the FNE00 feature. 

 

 
 

The screen below has the same configuration as the screen above except the Mobile Call 

Control box is not checked and the Twinned Mobile Number field is 916139675281. This is 

the configuration used during compliance testing for the twinning feature only. 
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5.11. Incoming Call Route 

An incoming call route maps an inbound DID number on a specific line to an internal extension.   

This procedure should be repeated for each DID number provided by the service provider.  To 

create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and 

select New.  On the Standard tab of the Details Pane, enter the parameters as shown below. 

 

 Set the Bearer Capability to Any Voice.  

 Set the Line Group ID to the incoming line group of the SIP line defined in Section 

5.8.44. 

 Set the Incoming Number to the incoming number on which this route should match.  

Matching is right to left. 

 Default values can be used for all other fields. 

 

 
 

On the Destinations tab, select the destination extension from the pull-down menu of the 

Destination field.  Click the OK button (not shown).  In this example, incoming calls to  

6471231111 on line 19 are routed to extension 29225. 
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Incoming Call Routes for other direct mappings of DID numbers to IP Office users listed in 

Figure 1 are omitted here, but can be configured in the same fashion.  

  

In the screen shown below, the incoming call route for Incoming Number 6471231112 is 

illustrated.  The Line Group Id is 19, matching the Incoming Group field configured in the SIP 

URI tab in Section 5.8.4. 

 

 
 

When configuring an Incoming Call Route, the Destination field can be manually configured 

with a number such as a short code, or certain keywords available from the pull-down menu.  For 

example, the following Destinations tab for an incoming call route contains the Destination  

FNE00 entered manually.  FNE00 is the short code for FNE Service, as shown in Section 5.99.  

An incoming call to 647-123-1112 will be delivered directly to internal dial tone from the IP 

Office, allowing the caller to perform dialing actions including making calls and activating Short 

Codes.  The incoming caller ID must match the Twinned Mobile Number entered in the User 

Mobility tab (Section 5.1010); otherwise the IP Office responds with a 486 Busy Here and the 

caller will hear a busy tone. 
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5.12. Save Configuration 

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the 

configuration performed in the preceding sections. 

 

The following will appear, with either Merge or Immediate selected, based on the nature of the 

configuration changes made since the last save.  Note that clicking OK may cause a service 

disruption.  Click OK if desired. 

 

 
 

6. Primus SIP Trunking Configuration 
Primus is responsible for the configuration of Primus SIP Trunking.  The customer will need to 

provide the IP address used to reach the Avaya IP Office at the enterprise.  Primus will provide 

the customer the necessary information to configure the Avaya IP Office SIP connection to 

Primus including:  

 

 IP address of the Primus SIP proxy  

 Supported codec  

 DID numbers  

 All IP addresses and port numbers used for signaling or media that will need access to the  

enterprise network through any security devices. 

 

This section provides verification steps that may be performed in the field to verify that the 

solution is configured properly. 
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6.1. System Status 

The System Status application is used to monitor and troubleshoot IP Office.  Use the System 

Status application to verify the state of the SIP trunk.  System Status can be accessed from Start 

→Programs →IP Office →System Status.  Or by opening an Internet browser and type the 

URL: http://ipaddress where ipaddress is the IP address of the Avaya IP Office LAN1 interface.  

Click on System Status to launch the application. 
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The following screen shows an example Logon screen.  Enter the IP Office IP address in the 

Control Unit IP Address field, and enter an appropriate User Name and Password.  Click 

Logon. 
 

 
 

Select the SIP line under Trunks from the left pane.  On the Status tab in the right pane, verify 

the Current State is Idle for each channel. 
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Select the Registration tab and verify that status of the SIP line is registered. Select the Alarms 

tab (not shown) and confirm there are no alarms for the SIP line. 

 

 
 

6.2. Monitor 

The Monitor application can also be used to monitor and troubleshoot IP Office.  Monitor can be 

accessed from Start →Programs →IP Office →Monitor.  The application allows the 

monitored information to be customized. To customize, select the button that is third from the 

right in the screen below, or select Filters →Trace Options. 
 

The following screen shows the SIP tab, allowing configuration of SIP monitoring.  In this 

example, the SIP Rx and SIP Tx boxes are checked.  All SIP messages will appear in the trace 

with the color blue. To customize the color, right-click on SIP Rx or SIP Tx and select the 

desired color. 
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As an example, the following shows a portion of the monitoring window for an outbound call 

from extension 29225, whose DID is 647-123-1111, calling out to the PSTN via the Primus IP 

Trunking Service.  The telephone user dialed is 1-613-967-5280. The IP address of Primus SIP 

trunking is being hidden for security reasons. 
 

 
 

7. Conclusion 
These Application Notes describe the configuration necessary to connect Avaya IP Office 8.0 to 

Primus SIP Trunking service.  Primus SIP Trunking is a SIP-based Voice over IP solution for 

customers ranging from small businesses to large enterprises.  It provides a flexible, cost-saving 

alternative to traditional hardwired telephony trunks.  Primus SIP Trunking passed compliance 

testing.  Please refer to Section 2.2 for any exceptions. 
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8. Additional References  
This section references documentation relevant to these Application Notes. In general, Avaya 

product documentation is available at http://support.avaya.com. 

 

[1] IP Office 8.0 IP Office Installation, Document Number 15-601042, Issue 25b, March 08, 

2012 

 

[2] IP Office Release 8.0 Manager 10.0, Document Number 15-601011, Issue 28h, March 28 

2012  

 

[3] IP Office System Status Application, Issue 06b, November 12, 2011 Document Number 15-

601758  

 

[4] IP Office Release 8.0 Administering Voicemail Pro, Document Number 15-601063, Issue 

27b, April 06 2012  

 

[5] IP Office System Monitor, Document Number 15-601019, Issue 02b 

 

Additional IP Office documentation can be found at:  

http://marketingtools.avaya.com/knowledgebase/ 

 

 

 

http://support.avaya.com/
http://marketingtools.avaya.com/knowledgebase/
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9. Appendix - SIP Line Template 
IP Office Release 8.0 supports SIP Line Template (in xml format) that can be created from an 

existing configuration and imported into a new installation to simplify configuration procedures 

as well as to reduce potential configuration errors. Note that not all of the configuration 

information, particularly items relevant to specific installation environment, is included in the 

SIP Line Template. Therefore it is critical that the SIP Line configuration be verified/updated 

after a template has been imported and additional configuration be supplemented using Section 

5.8 in these Application Notes as a reference. 

 

9.1. Configure IP Office Manager for Template Creation  

To enable IP Office to create a SIP Trunk template, configure as follows on the desktop where 

the IP Office Manager is installed: 

 

1. Navigate to File  Preferences on the IP Office Manager and select the Visual Preferences 

tab. Check the Enable Template Options box as shown below. 
 

 
 
 

2. Run regedit on the desktop and navigate to 

HKEY_CURRENT_USER/Software/Avaya/IP400/Manager and add a DWORD value 

TemplateProvisioning and set its value to 1. Reboot the server hosting the IP Office 

Manager. 
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9.2. Generate a SIP Trunk Template  

To generate a SIP Trunk template from an existing SIP trunk, execute the following steps:  

 

1. Select the SIP trunk under line and right click on the SIP line number for which the SIP trunk 

template is to be generated and then click Generate SIP Trunk Template. 
 

 
 

2. In the SIP Trunk Template screen shown below, enter a template name in the Descriptive 

Name field and click Export. 
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3. In the Template Type Selection screen, enter Country and Service Provider and click 

Generate Template. 
 

 
 

A popup screen shows up (not shown) asking where the template is to be stored. This section 

shows an example SIP Trunk Template generated from the configuration presented in this 

document. 

 
<?xml version="1.0" encoding="utf-8" ?>  

- <Template xmlns="urn:SIPTrunk-schema"> 

  <TemplateType>SIPTrunk</TemplateType>  

  <Version>20120604</Version>  

  <SystemLocale>enu</SystemLocale>  

  <DescriptiveName>ToPrimus</DescriptiveName>  

  <ITSPDomainName>preprod.bvoice.primus.ca</ITSPDomainName>  

  <SendCallerID>CallerIDPAID</SendCallerID>  

  <ReferSupport>true</ReferSupport>  

  <ReferSupportIncoming>2</ReferSupportIncoming>  

  <ReferSupportOutgoing>2</ReferSupportOutgoing>  

  <RegistrationRequired>false</RegistrationRequired>  

  <UseTelURI>false</UseTelURI>  

  <CheckOOS>false</CheckOOS>  

  <CallRoutingMethod>1</CallRoutingMethod>  

  <OriginatorNumber />  

  <AssociationMethod>SourceIP</AssociationMethod>  

  <LineNamePriority>SystemDefault</LineNamePriority>  

  <ITSPProxy>xx.xx.xx.xx</ITSPProxy> (note here that the service provider IP address is 

hidden for security reasons) 

  <LayerFourProtocol>SipUDP</LayerFourProtocol>  

  <SendPort>5060</SendPort>  

  <ListenPort>5060</ListenPort>  

  <DNSServerOne>0.0.0.0</DNSServerOne>  

  <DNSServerTwo>0.0.0.0</DNSServerTwo>  

  <CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>  

  <SeparateRegistrar />  

  <CompressionMode>AUTOSELECT</CompressionMode>  

  <UseAdvVoiceCodecPrefs>false</UseAdvVoiceCodecPrefs>  

../../../../Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/UZN65OUG/CA_Primus_SIPTrunk.xml
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  <CallInitiationTimeout>4</CallInitiationTimeout>  

  <DTMFSupport>DTMF_SUPPORT_RFC2833</DTMFSupport>  

  <VoipSilenceSupression>false</VoipSilenceSupression>  

  <ReinviteSupported>true</ReinviteSupported>  

  <FaxTransportSupport>FOIP_T38</FaxTransportSupport>  

  <UseOffererPrefferedCodec>false</UseOffererPrefferedCodec>  

  <CodecLockdown>false</CodecLockdown>  

  <Rel100Supported>false</Rel100Supported>  

  <T38FaxVersion>3</T38FaxVersion>  

  <Transport>UDPTL</Transport>  

  <LowSpeed>0</LowSpeed>  

  <HighSpeed>0</HighSpeed>  

  <TCFMethod>Trans_TCF</TCFMethod>  

  <MaxBitRate>FaxRate_14400</MaxBitRate>  

  <EflagStartTimer>2600</EflagStartTimer>  

  <EflagStopTimer>2300</EflagStopTimer>  

  <UseDefaultValues>true</UseDefaultValues>  

  <ScanLineFixup>true</ScanLineFixup>  

  <TFOPEnhancement>true</TFOPEnhancement>  

  <DisableT30ECM>false</DisableT30ECM>  

  <DisableEflagsForFirstDIS>false</DisableEflagsForFirstDIS>  

  <DisableT30MRCompression>false</DisableT30MRCompression>  

  <NSFOverride>false</NSFOverride>  

- <SIPCredentials> 

  <Expiry>60</Expiry>  

  <RegistrationRequired>true</RegistrationRequired>  

  </SIPCredentials> 

  </Template> 

../../../../Local%20Settings/Temporary%20Internet%20Files/Content.Outlook/UZN65OUG/CA_Primus_SIPTrunk.xml
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9.3. Create SIP Trunk from Template 

To create a SIP Trunk from template shown above, execute the following steps: 

 

On the PC where IP Office Manager was installed, copy and paste the above template into a text 

document named US_Primus_SIPTrunk.xml (the file must be named EXACTLY as show).  

Move the .xml file to the IP Office Manager template directory (C:\Program Files\Avaya\IP 

Office\Manager\Templates). 

 

Right click on Line, select New and click New SIP Trunk From Template. 
 

 
 

In the Template Type Selection screen displayed, verify that Country and Service Provider 

fields are auto populated with the information configured in Section 9.2. Click Create new SIP 

Trunk. 
 



 
RS; Reviewed: 

SPOC 7/6/2012 

Solution & Interoperability Test Lab Application Notes 

©2012 Avaya Inc. All Rights Reserved. 

34 of 34 

PrimsSipTrkIPO8 

 

 

 
 

©2012 Avaya Inc. All Rights Reserved. 

Avaya and the Avaya Logo are trademarks of Avaya Inc.  All trademarks identified by ® and 

™ are registered trademarks or trademarks, respectively, of Avaya Inc.  All other trademarks 

are the property of their respective owners.  The information provided in these Application 

Notes is subject to change without notice.  The configurations, technical data, and 

recommendations provided in these Application Notes are believed to be accurate and 

dependable, but are presented without express or implied warranty.  Users are responsible for 

their application of any products specified in these Application Notes. 

 

Please e-mail any questions or comments pertaining to these Application Notes along with the 

full title name and filename, located in the lower right corner, directly to the Avaya 

DevConnect Program at devconnect@avaya.com. 

 

 

mailto:devconnect@avaya.com

